RIPE NCC

RIPE NETWORK COORDINATION CENTRE

RIPE Atlas

Global Measurement Network

Christian Teuschel | October 2019 | ESNOG 24



RIPE Atlas &

e ....Is aglobal, open, distributed Internet measurement platform,
consisting of thousands of measurement devices that measure
Internet connectivity in real time
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Global active measurements platform (.

 Goal: View Internet reachability
* Probes hosted by volunteers
e Measurements towards root name servers

- Visualised as Internet traffic maps

* Users can also run customised measurements
- ping, traceroute, DNS & SSL/TLS, NTP and HT TP~

e Data publicly available
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RIPE Atlas measurements &

e Built-in global measurements towards root nameservers

- Visualised as Internet traffic maps

e Built-in regional measurements towards "anchors”

e Users can run customised measurements
- ping, traceroute, DNS, SSL/TLS, NTP and HTTP
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Probes and Anchors

10,000+ probes connected (almost 500 Anchors)

e 7,500+ results collected per second
e 21,000+ measurements currently running
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RIPE Atlas Overwew
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RIPE Atlas Global Coverage
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&

Most Popular Features

e Six types of measurements: ping, traceroute, DNS, SSL/TLS,
NTP and HTTP (to anchors)

e APIls and CLI tools to start measurements
and get results

e Streaming data for real-time results

e Status checks
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Using
RIPE Atlas As a Visitor




Internet Traff

RIPE Atlas «
About RIPE Atlas >
Get Involved >
Probes and Anchors >

Measurements, Maps and Tools v

Measurements

Internet Maps

Tools
Resources >
RIPE NCC Members
My Atlas >

Staff Pages >

Ic Maps

Internet Maps

DNS Root Instances

Shows, for each probe, which root DNS
server instance the probe ends up
querying, when they ask a particular
root server. In other words, it shows the
"gravitational radius" for root DNS
server instances.

RTT to Fixed Destinations

e

Shows the colour coding for the RTT
value for the particular destination for
each probe. The minimum / average /
maximum values are based on standard
"ping” measurements.

Comparative DNS Root RTT

Shows a comparison of response time
for DNS SOA queries to all the root DNS
servers. For each probe, a marker
shows the "best" root server with colour
identifying the related minimum
response time.

Reachability of Fixed
Destinations

Shows if the particular fixed destination
is reachable or not from each probe.
Red markers indicate that the specific
destination for these probes are
unreachable and green reachable.
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Root Server Performance

This map shows the reply time to the
SOA query of a particular root DNS
server, over the selected transport
protocol (UDP, TCP or comparison of
the two) for each probe.
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Where is B-root?

We display measurement results from the last hour only.

KT \

Leaflet | Tiles @ Esri — Esri, DeLorme, NAVTEQ
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Probes per country (in RIPEstat)

Map  Satellite

Google

Showing results for es

source data

RIPE Atlas Probes (es)

Found 391RIPE Atlas probes in this network:

V Connected (158) V Abandoned (217) V Disconnected (16)

¥ f’y o,
b JONT Croat

0rocco, -

-

Western

Algeria

Switch to table view

y Pas Al

. Y r-
5o o Y, La f
3 @Rome

I'yirhenian Sea “
=

Mediterraneai

==

‘Tunisia

——— —

Map data ©2019 Google, INEGI, ORION-ME Terms of Use

embed code permalink Info

https://stat.ripe.net/es#tabld=activity
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Probes per country (in RIPEstat)

7

.

RIPE Atlas Probe Deployment (es)

O Multi-resource

250 IPesta
S0 e~
<
150
: Monday, Oct 7, 2019
100 L » Spain(abandoned): 217
¢ Spain(connected): 157
- Spain(disconnected): 17
50
0
2015 2016 2017 2018 2019
-0~ Spain(abandoned) -# Spain(connected) Spain(disconnected)

Showing results for cc_es as of 2019-10-08 09:00:00 UTC

source data embed code permalink Info

L ——— R ———————

» https://stat.rige.net/es#tabld=activity
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https://stat.ripe.net/es#tabId=activity

&

Where we want to place probes
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Looking Up Public Probes




Searching for Probes

Manage IPs and ASNs >

- RIPE NCC

RIPE NETWORK COORDINATION CENTRE

Participate

'n You are here: Home > Analyse > Internet Measurements > RIPE Atlas > Probes

|
Probes

This is a list of all current RIPE Atlas probes, including information specific to each probe. More probes are continually coming online. __

® |Learn more about probes

e See the probes map

® Apply for your own probe

Public Login to see more

Id ASN v4 ASN v6
6175 1103 1103
6146 60781 60781
6152 28753 28753
6137 3333 3333
6147 33280 33280
6112 197216 197216
6161 27843 27843
6142 63403 63403
6008 2607 2607
6001 3333 3333

Country

HERZDIRINNIHII

Filter by id/asn/country/description

Description

SURFnet bv

Leaseweb Network B.V.
Leaseweb Network B.V.
nl-ams-as3333-preprod
Afilias

Delta Softmedia Ltd
Optical Technologies
Afilias

AA sk-bts-as2607

AA nl-ams-as3333

atabase (Whois Website “ \

= = =
—
_ g -

~

N

7" Filter based on ™\

\«

Search |P Address or ASN Q AS N y co u ntry, /

N - ///,

Get Support > Publications About Us > " ol |Ocatl on... //' -
Y
T N S .
— = . . //,/’
— — ———
_ ~ /;; =
Any Status j IPva/ve j Any Country j n
Connection Status =

& 4 weeks o
& 4 weeks o
& 4 weeks o’
& 4 weeks o’
& 4 weeks a’
& 4 weeks o’
& 4 weeks o’
& 4 weeks o
& 4 weeks o
& 4 weeks o’
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https://atlas.ripe.net/probes
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https://atlas.ripe.net/probes/

Probe Page

» You are here: Home > Analyse > Internet Measurements > RIPE Atlas > Probes > Probe #10010

PrObe #1 001 0 (Register) = & 3 days, 9 hours
Firmware
General Network Built-in Measurements User-defined Measurements s #1 001 O
. . Architecture
General Information Connection & Traffic E ey
Id 10010 (®Bits/s Packets/s MAC Address
MAC F8:D1:11:A9:F3:2C L S
Address
25k . . .
Architecture tl-mr3020 %W The displayed location is an
automatic best guess of the
5"'")”” e  4680(1070) ’ 08:00 12:00 city based on IP address.
ersion
By manually setting a more
Router Type dTi o 5 e o accurate location you can help
Bandwidth  Not set Connected Time ays, ¥ hours to improve the usefulness and

Limit correctness of RIPE Atlas.
DNS Entry  Off

Shared Yes April May Update Location (¢

Publicly
SEULL SR NAT | Chello 200MB ; +
System | V3 | Resoives A Correctly = l Het 1]
Tags | Resolves AAAA Correctly | IPvd Works %
IPv4 RFC1918
Management Sharing

Only the probe host is permitted to administer this probe.
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Zoomable Ping Graph

* Replace multiple RRD graphs: zoom in/out in time, in the same
graph

e Easier visualisation of an event's details

* Selection of RTT class (max, min, average)

Current data point resolution: no aggregation applied B zoom out @ download
2
2015- 5 UTC
RTT M s
1.5
")
E
t 1
(+ 4
0.5
0
07:00 08:00 09:00 10:00 11:00 12:00 13:00 14:00

Minimum  Average Maximum  95th percentile

— RTT Min 0.582ms 0.62ms 0.65ms 0.64ms
— RTT Med 0.613ms 0.65ms 0.791ms 0.698ms
— RTT Max 0.673ms 0.77ms 1.63ms 0.862ms

o No data o =0% o >0% o >30% s >60% = 100% Pkt Loss o 0 Pkts sent

Showing results for 10010/2 from 2015-05-22 06:21:40 UTC to 2015-05-22 14:17:42 UTC

See this on RIPEstat

Christian Teuschel | ESNOG 24 | October 2019

&

18



Searching probes with the API

 endpoint https://atlas.ripe.net/api/v2/probes/
e different formats, e€.9. geojson

_ ) RIPE Atlas api - RIPE Atlas — R’ X [iEg

also works w a

Q% meaoyYy = o » bvowsev!

&« C ® @ https://atlas.ripe.net/api/v2/probes/27460 E
Login
RI PE Ncc RIPE Database (Whois) Website
RIPE NETWORK COORDINATION CENTRE Search IP Address or ASN Q
Manage IPs and ASNs > Analyse Participate > Get Support Publications About Us >

b You are here: Home > Analyse > Internet Measurements > RIPE Atlas > Not Found API View > Probe List > Not Found

Api view Probe Detail

GET /api/v2/probes/27460

HTTP 200 OK
Allow:
Content-Type:
Vary:
{
"address_v4": "83.160.104.137",
"address_v6": '"2001:982:486a:1:c66e:1fff:fe5b:e47e",

"asn_v4": 3265,
"asn_v6": 3265,

"country_code": "NL",
"description": "Jasper Home",
"first_connected": 1476004586,
"geometry": {

"type": "Point",
"coordinates": [

4.8705,
52.3675
]
}I
"id": 27460,

"is_anchor": false,
"is_public": true,
"last_connected": 1567673726,
"prefix_v4": "83.160.0.0/14",
"prefix_v6": "2001:980::/30",
"status": {

Christian Teuschel | ESNOG 24 | October 2019 19




%

Finding Results of
Public Measurements



ing up Measurements Results

Manage IPs and ASNs >

1

You are here: Home > Analyse > Internet Measurements > RIPE Atlas > Measurements

Measurements

ID

9278562

9278557

9278556

9278555

9278554

9278553

9278550

Search by target

Traceroute DNS

Type
Ping

Ping

Ping

Ping

Ping

Ping

Ping

Target

www.ripe.net

185.15.245.163

123.126.20.54

r1.d1.de.recast-it.net

r1.al.nl.recast-it.net

2001:6a8:28c0:2017::00:00:FF

2001:6a8:28c0:2017::00:00:FF

Analyse Participate > Get Support
v Search... Any Status v IPv4/v6
HTTP SSL NTP WiFi Built-in Anchoring
Description

Ping measurement to www.ripe.net

From script for latency checks for Monitoring

check unicom

From script for latency checks for Monitoring

From script for latency checks for Monitoring

Ping 6 BLUE measurement to 2001:6a8:28c0:2017::00:00:FF

Ping6 measurement to 2001:6a8:28c0:2017::00:00:FF
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Publications

v Alltypes +

Probes Interval

8 one-off
35 one-off
10 one-off
35 one-off
35 one-off
956 one-off

484 one-off

About Us

Time (UTC) +« Status

08-09-2017 14:02 O
Never

08-09-2017 13:58 O
Never

08-09-2017 13:51 [l
08-09-2017 14:00

08-09-2017 13:50 [
08-09-2017 14:00

08-09-2017 13:50 [l
08-09-2017 14:00

08-09-2017 13:49 L]
08-09-2017 13:55

08-09-2017 13:42 L]
08-09-2017 13:50

https://atlas.ripe.net/measurements/
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Avalilable visualisations: pi

Probe 4 ASN (v4) 4 ASN (v6) $ % 4 Time 4 RTT
6019 3333 3333 = & 2015-05-1909:23 I
] . 6069 59469 59469 i= & 2015-05-19 09:23 )
o | ist of pro bes: sortable by RTT o e s = e wswen
- 6112 197216 197216 = & 2015-05-1909:23

10008 3851 E & 2015-05-1909:23
10218 6876 = & 2015-05-1909:23
10246 39608 = & 2015-05-1909:23 ‘ ‘
10252 50288 = & 2015-05-1909:23 I
10267 12322 il & 2015-05-1909:23 ( )
10296 51214 = & 2015-05-1909:23 x Unreachable

e Map: colour-coded by RTT
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e LatencyMON: compare multiple latency trends
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10%
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40% [ A n i | as1101.anchors.atias.ripe.net
30% . / o} [\ R ) |
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Y
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Available visualisations: traceroute

e TraceMON: network to

* |PMap(beta): hops geolocation on map (prototype)

Traceroutes to 74.125.206.94 from 8 of 10 probes [select] at March 10th 2017, 18:47:31 UTC

Traceroute Visualisation (BETA) m spood: ® l Focus on n

Nodes label: @ Auto () Reverse lookup () Country code

[7] Latency [ H ISOme traceroutes don't reach the target ; ) ]Nl the traceroutes don't reach the target

16th August, 21:41

RIPE NCC Probe 964 Probe 898 TPmbnu Tmbus Probe 446 Probe 4721 Probe 929
O asaa612 © Asa40s7 [ o Oasarros O As132696 O Asagse
L O Asas019 Q Asasaos O as12322 Q asarros SGIX Q Asasse
QAss0673 () AS34019 P O as12322 QEmtel Q Google O Asso89
© As20562 Q As34019 O Asagaos O As12322 O Emtel O Google O Asso089
Q As24785 France-IX O Asa9309 O As12322 O Google O Google Px*
NL-IX AMS-IX O Google © Google O Google Q Asso08s
Q Google O Google O Google © Google @Q Google © Google
Q.Google © Google © Google Q Google Q Google
@ Google © Google Q Google © Google Q Google © Google
O Google OGoogle QGoogle © Google O Google
OGaggle OGaggle {J Google OGoogle
(JGoogle
(L) Google
@ Source OTarget (OHost @IXP PrivateIP  No e G 11111 Di
51.5ms RIPE NCC
S1ms
50.5ms
49.5ms
49ms
48.5ms
48ms
15:00 15:30 16:00 16:30 17:00 17:30 18:00 18:30

10th March, 14:57 — 10th March, 18:47

16th August, 21:41 15th October, 14:06 14th December, 06:31

I ' ‘G\ [ I

11th February, 22:56 12th April, 1521

D { Embed in your page About TraceMON
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General Information Probes Map LatencyMON TraceMON

Bostondge

San Jose ’Washington, D.C.

Los___AngeIes @Dalla

AN %
N\
L

pology, latency and nodes information

IPmap (beta) Results

©

" Oleeds
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B L D T o
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https://labs.ripe.net/Members/massimo_candela/tracemon-traceroute-visualisation-network-debugging-tool
http://github.com/RIPE-Atlas-Community/openipmap

Available visualisations: traceroute

* List of probes, colour-coded number of hops

¥ www.seil.jp

Christian Teuschel | ESNOG 24 | October 2019 24



Available visualisations: DNS

* Map, colour-coded response time or diversity

o List of probes, sortable by response time

AVIN LS VL re [ e Rl o s ¥
North®2 5/ ‘ o

Sea

! L Vog,
UNITED o ' o
"KINGDOM . 4y
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RA L

URAL MOy

Atis,  MONGOLI

P -~ Lake 4)'/1/
= Balklias) &
Black Sea i) Balkitasj . GO B

5 it ¥ TURKEY P {ySH
: CRECE: - x"'«Q nu\\.
I/(,,/,,,l ' sl ; & ‘s,\‘ /l'l"‘ 08
'r"l/lﬂ'(ln So 24 ”'/"’5/ 1y
an an Sea . IRAN 6«/4, %, CH ]}\
' 3 4
ALGERIA LIBYA bSeR o L > &k A
,(; i L ; r:'.'rn\-,-_
S A H A R A SAUDI -
= ARABIA INDIA

MALI ‘ ‘

ioes
™ AITSTTY A I ... -

i — Esri, DeLorme, NAVTEQ, TomTom, Intermap, iPC, USGS, FAQ, NPS, NRCAN, GeoBaée. Kadaster NL, Ordrian'ce éurvey. Esri Japan, METI, Esri China (Hong Kong), a

<10ms. <20ms. <30ms“ <40ms. <50ms. <100ms“ <200ms“ <300ms“ <500ms. NoData.
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DNS measurement to ns1.opteamax.de

General Information Probes Map Download Results Modification Log
Probe 4 ASN (v4) 4 ASN (v6) & $ ¢ Time

17840 6327 il &  2015-05-1909:38
18035 43030 — &  2015-05-19 09:50
18129 327805 &  2015-05-1909:49
15844 32098 M &  2015-05-1909:48
17857 852 il &  2015-05-19 09:37
19894 6327 il &  2015-05-1909:36
19204 21513 il &  2015-05-19 09:50
15922 30036 E &  2015-05-1909:47

Name

null
null
null
null
null
null
null

null

Response Time



Downloading Measurements Results

e Click on "Results”, then "Download”
e Or URL

O O I AP I %% Calibration for anchoring measurement: IPv6 Traceroute for
ke-nbo-as37578.anchors.atlas.ripe.net

. General Information Probes Map OpenlPMap Prototype Results
® I {es U ItS I n J S O N Download the raw measurement result data here.

You can use this form to download the data through your browser, or use the preview on the right to help you query the REST

I n I n f n API directly.
I g Select Your Timeframe URL Preview

Start 2017-09-13 (start time of this measuremer + https://atlas.ripe.net/api/v2/measurements/9304

Date*: 064/ results/?start=1505260800&stop=1505347199&F
All dates are start-of-day CEmesSi 200

Stop 2017-09-13 (start time of this measuremer 4

Date*:
All dates are end-of-day

Format: ‘ ISON

R — e —————_

Christian Teuschel | ESNOG 24 | October 2019 20



Looking at the Result

[{“af":6,"avg" 61.32,
"dst addr":"2a00:1450:4004:802::1014",“dst name":"www.google.com",
“dup":0,
“from":"2001:8a0:7£f00:b201:220:4aff:fec5:5b
“fw":4660,"1ts":411,

“max”:62.148, "min":60.372,

“msm 1d":1004005, "msm name":"Ping",

"prb id":722,"proto":"ICMP", "rcvd":10,

sresult":[{"rtt":62.148}, {"rtt":61.437},{"rtt":61.444},{"rtt":61.448},{"rtt";

60.372},{"rtt":60.373},{"rtt":61.384},{"rtt":61.267}1],
“sent":10,"size"64,
“src addr":"2001:8a0:7£f00:b201:220:4aff:fec5:

"step":240, "timestamp”:1410220847,"ttl1":54,"type" :"ping"},

Christian Teuschel | ESNOG 24 | October 2019

rtt"
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Search for Measurements by Target in RIPEstat

RIPEstat — Internet Measurements and Analysis

j=rlR T R T R e S T D I T O A L R e T D R O T R R e S S I T O oy R e T R T iy R S e R T T R O a T R I e S T I I TS Oy R S I T

You are here: Home > Data & Tools > RIPEstat > atlas-targets

Go to “RIPEstat > Sy
“RIPE Atlas Activity” |

RIPE Atlas Measurement Targets (8.8.8.8)

8.8.8.8

Show [ 10 % ]targets/page

Measurement
ID

w

1040720 ‘&

1006491 (@
1006192 (&
1004827 (&
1002630 (&

1478085 (&

Stopped

ongoing

ongoing
ongoing
ongoing
ongoing

2014-02-24
13:41 UTC

Christian Teuschel | ESNOG 24 | October 2019

w

Type +

ping
traceroute
ping
traceroute
ping

dns

Search:

Target

P ¢ Target Hostname

google-public-dns-

8.8.8.8
a.google.com

8.8.8.8 not specified
8.8.8.8 not specified
8.8.8.8 not specified
8.8.8.8 not specified

8.8.8.5 not specified

28



Finding one specific measurement

* |f you know the measurement ID:

- https://atlas.ripe.net/measurements/ID

- https://atlas.ripe.net/measurements/2340408/

Christian Teuschel | ESNOG 24 | October 2019 29



Use Existing Measurements %)

* Many measurements already running!
e Search for existing public measurements first...
* Only then schedule your own measurement

Christian Teuschel | ESNOG 24 | October 2019 30
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Creating a Measurement




Benefits of your own measurements

 Customer problem: cannot reach your server

- Schedule measurements (pings or traceroutes) from up to 1,000 RIPE Atlas probes
worldwide to check where the problem is

 Measuring packet loss on suspected "bad” link
e Testing anycast deployment

Christian Teuschel | ESNOG 24 | October 2019 32



Logging In

 Log in to atlas.ripe.ne
- Use your RIPE NCC Access account

- Same account for LIR Portal, RIPE Atlas, RIPEstat,

- Create an account if you don't already have one

Login
RI PE N c c RIPE Database (Whois)
RIPE NETWORK COORDINATION CENTRE A N Q
Manage IPs and ASNs > Analyse Participate > Get Support > Publications About Us >

1 You are here: Home > Analyse > Internet Measurements > RIPE Atlas

About RIPE Atlas >
With your help, the RIPE NCC is building Probes connected to RIPE 9397

Get Involved > Atlas

the largest Internet measurement
Probes and Anchors 5 network ever made. RIPE Atlas employs a

global network of probes that measure Measurements currently 171986

runnin
Measurements, Maps and Tools > Internet connectivity and reachability, - \ N s
Resources > providing an unprecedented Results collected per second 3737
understanding of the state of the Internet Get Involved
RIPE NCC Members

in real time.

O\

Already a RIPE Atlas user? Log Find out how RIPE Atlas can
in with your RIPE NCC Access help you monitor your ICANN
account. network, troubleshoot issues,
analyse DNS infrastructure, Become a Sponsor >

test IPv6 connectivity and

Christian Teuschel | ESNOG 24 | October 2019

RIPE NCC

RIPE NETWORK COORDINATION CENTRE

Manage IPs and ASNs > Analyse

You are here: Home > Access

Sign in using your RIPE
NCC Access account

If you don't have a RIPE NCC Access
account, click here to create one.

New: Two-step verification. Learn
more...

RIPE Labs...

RIPE Database (Whois)

Participate > Get Support >
Email
I Your email address
Password
Your password
m Forgot your password?

Pu
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http://atlas.ripe.net

Credits system

e Measurements cost credits

- ping = 10 credits, traceroute = 20, etc.

* Why? Fairness and to avoid overload
e Spending limit and max number of measurements

Christian Teuschel | ESNOG 24 | October 2019
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Credits overview

RIPE NETWORK COORDINATION CENTRE Search the content of this website

FWEIT INIWE NJUATRAT TN

/)

Manage IPs and ASNs > Analyse Participate > Get Support > Publications About Us

You are here: Home > Analyse > Internet Measurements > RIPE Atlas > My Atlas > My Credits

RIPE Atlas « Cred itS
About RIPE Atlas 1 O 1
Here you can see the history of your credit use and current 5 3 ’ ’

’ . /

Probes and Anchors voucher for credits if you have one.

Measurements, Maps and Tools

VoV VYV

(8] History il Charts & Archives — Transfer = Standing Order & Redeem voucher

Give credits
to someone

Resources

RIPE NCC Members

My Atlas Vv

Credits

Comnme Change Balance

API Keys

Prob + 108,000 153,033,561

Messages My Atlas > Credits Probe [t + 108,000 152,925,561
Anchors Probe ID:6019 AnCNOTTp extra credit + 108,000 152,817,561
Settings Probe ID:6019 Anchor host 5x extra credit + 108,000 152,709,561
Staff Pages > 2016-02-02 01:02 UTC Probe ID:6019 Anchor uptime 5x extra credit + 108,000 152,601,561
2016-02-02 01:02 UTC Probe ID:6019 Anchor host 5x extra credit + 108,000 152,493,561

2016-02-01 01:02 UTC Probe ID:6019 Anchor uptime 5x extra credit + 108,000 152,385,561

2016-02-01 01:02 UTC Probe ID:6019 Anchor host 5x extra credit + 108,000 152,277,561
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Scheduling a measurement with the web interface &

* Log In to atlas.ripe.net

 Navigate to Measurements, Maps and Tools -> Measurements In
the left hand sidebar

* Click the green 'Create a Measurement on the right side of the
page
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Scheduling a measurement (2)

Create a New Measurement
step1 Definitions

.| v Ping measug

Costs summary
ent to bbc.co.uk x Daily cost: 10800 credits
Description: : R
You will run out of credits
:O.Jk i - Ping measurement to bbc.co.uk in about 124 days
An |P address or hostname ——————
Interval: o
Address Family*: 240 A .
- L T L 2 |
Pvd v How often this should be done (seconds ) 2 ® S
L 2 = 2, BN
between samples). Note that this value Is 2 =4 P-4 <
<_, - ,:‘ -
Packets: lgnored for one-off measurements. ® M Balance
3 v
Resolve on Probe: B Total Expenses
Size: Force the probe to do DNS resolution
48 A Users who will supply
credits for this
measurement:
> Advanced Options
ferenc@ripe.net H
step2 Probe Selection
Worldwide 10

Step3 | Timing

This is a One-off:

Start time (UTC):

Stop time (UTC):

> Measurement APlI Compatible Specification
Christian Teuschel | ESNOG 24 | Oc
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Scheduling a measurement (3) (@)

* Recurring measurement: mostly used for a periodic, long-term
measurement, or..

* One-off measurement: one run on all selected probes.

e Choose type, target, frequency, start/end time, # of probes,
region...

 Each measurement will have unique ID
e “APIl Compatible Specification” is generated too
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Selecting probes with new-set-wizard
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Use Cases




Use cases (1)

Using RIPE Atlas to Validate International Routing
Detours

Anant Shah — 30 Jan 2017

A Quick Look at the Attack on Dyn

Massimo Candela & — 24 Oct 2016
Contributors: Emile Aben

Using RIPE Atlas to Monitor Game Service
Connectivity

Annika Wickert — 14 Sep 2016

Using RIPE Atlas to Measure Cloud Connectivity

Jason Read — 06 Sep 2016

Using RIPE Atlas to Debug Network Connectivity
Problems

Stéphane Bortzmeyer — 10 May 2016

Christian TeusemeMrESNOG ZZ T OCIODET ZUTY
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RIPE Atlas IXP Country Jedi (1) 2

Do paths between ASes stay in country?
* Any difference between IPv4 and IPv6?
e How many paths go via local IXP?

 Could adding peers improve reachability?

https://www.ripe.net/ixp-country-jedi

 Experimental tool

- Feature requests welcome!

- Depends on probe distribution in country
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RIPE Atlas IXP Country Jedi (2)

e Methodology

- Trace route mesh between RIPE Atlas probes

- Identifying ASNs in country using RIPEstat
- Identifying IXP and IXP LANs in PeeringDB
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Figure 1: Visual representation of IPv4 paths (left) and IPv6 paths (right) between selected RIPE Atlas probes in Sweden
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Use Cases (2)

e DDoS Attack on Dyn DNS Servers (Oct. 2016)

- 10s millions devices - Mirai botnet

- Legitimate requests

[+ BE Streaming on @ MIEB 4AAR P N

ASd & MOALNOMeN! 1O Stan Feom 2016-10-20 0638 10 2016-10-23 1438

200.70.71.6 (6 prosis P

3

53 is5583 §s535y Fs533%

9

§ 3

i

EEER
v
4
§
X

8
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Use Cases (3)

* Monitor Game Service Connectivity (Sept. 2016)

e Requirements:

- Check General Reachability, Latency, Historical data

- Supported by an active and helpful community

- Integrate with their existing logging system

* Track down an outage in one upstre

e Became sponsors
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RIPE Atlas - EU

RIPE Atlas - EU

0 Drag widgets to any position you like in unlock / edit mode.

1d: RTT for IT a few seconds ago
7

2
as]( t 1 g
O

T T T T T T
21:00 Fri 09 03:00 06:00 09:00 12:00 15:00 18:00
Time

B mean ripe_atlas_avg_rtt, "ripe_atlas_country:IT" mean ripe_atlas_max_rtt, "ripe_atlas_country:|T"
mean ripe_atlas_min_rtt, "ripe_atlas_country:IT"

Values

1d: RTT for GB a few seconds ago

Values
P
8 2
o 8 8
I

T - T T = T T T
21:00 Fri 09 03:00 06:00 09:00 12:00 15:00 18:00

B mean ripe_atlas_avg_rit, "ripe_atlas_country:GB" mean ripe_atlas_max_rtt, "ripe_atlas_country:GB"
mean ripe_atlas_min_rtt, "ripe_atlas_country:GB"

1d: RTT for NL a few seconds ago

Values

@ g
o 83
!

T T T T T
21:00 Friog 03:00 06:00 09:00 12:00 15:00 18:00
Time

M mean ripe_atlas_avg_rtt, "ripe_atlas_country:NL" mean ripe_atlas_max_rtt, "ripe_atlas_country:NL"
mean ripe_atlas_min_rtt, "ripe_atlas_country:NL"

1d: RTT for NO

Values

Update in background Unlock / Edit

a few seconds ago

T
15:00 18:00

B mean ripe_atlas_avg_rtt, "ripe_atlas_country:NO" mean ripe_atlas_max_rtt, "ripe_atlas_country:NO"

mean ripe_atlas_min_rtt, "ripe_atlas_country:NO"

1d: RTT for AT

a few seconds ago

T T T
21:00 Fri0og 03:00 06:00

B mean ripe_atlas_avg_rtt, "ripe_atlas_country:AT" mean ripe_atlas_max_rtt, "ripe_atlas_country:AT"

mean ripe_atlas_min_rtt, "ripe_atlas_country:AT"
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Use Cases (4)

e Amsterdam Power Outage (March 2015)
 \When and where the outage was happening

Enkhuizen

Katwijk 2m
aan Zee

Wassenaar

: : A ” 4.’. -4 ‘?
hen aan
n Rijn ~ 3
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%

Take Part In the
RIPE Atlas Community



RIPE Atlas community (part 1)

e \Volunteers host probes in homes or offices
e Organisations host RIPE Atlas anchors

e Sponsor organisations give financial support or host multiple
probes In their own networks

Christian Teuschel | ESNOG 24 | October 2019
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RIPE Atlas community (part 2)

e Ambassadors help distribute probes at conferences, give
presentations, etc.

e Developers contribute free and open software

e Network operators create measurements to monitor and
troubleshoot

 Researchers and students write papers

Christian Teuschel | ESNOG 24 | October 2019
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Hosting a probe &

 Create a RIPE NCC Access account
* (Go to https://atlas.ripe.net/apply

* You will receive a probe by post

e Register your probe

* Plug In your probe

 |f you receive a probe from an ambassador (trainer, sponsor,
someone at a conference), just register it and plug it in!
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Questions

christian.teuschel@ripe.net
@christian_toysh




